
หน่วยการเรียนที่ 6   
การประมวลผลและวิเคราะห์ข้อมูลภาพถ่ายทางอากาศ 

 
เนื้อหาประจ าหน่วยเรียน 
 1. การจัดท าแบบจ าลองพ้ืนผิว/วัตถุแบบ 3 มิติจากข้อมูลภาพถ่ายทางอากาศ    
 2. การประมวลผลข้อมูลภาพเพ่ือสร้างภาพถ่ายดิ่ง (Orthophto) 
จุดประสงค์การเรียนรู้ที่คาดหวัง 
 เมื่อผู้เรียนได้ศึกษาในหน่วยการเรียนรู้ที่ 6 แล้วมีความสามารถดังนี้  
 1. ผู้เรียนสามารถบอกหลักการและปฏิบัติตามขั้นตอนการประมวลผลภาพ ด้วยโปรแกรม 
Image composite editor และAgisoft PhotoScan ได้อย่างถูกต้อง 
 2. ผู้เรียนสามารถเลือกวิธีการบันทึกชนิดแฟ้มข้อมูลและส่งออกข้อมูลได้อย่างเหมาะสม 
 3. ผู้เรียนมีสมรรถนะในการปฏิบัติงานการประมวลผลข้อมูลภาพจาก UAV เพ่ือน าไป
สร้างแผนที่และแบบจ าลองพ้ืนผิว 3 มิติได้อย่างแม่นย าและเหมาะสม 
จ านวนชั่วโมงที่สอน : ก าหนดสัดส่วนชั่วโมงบรรยาย 2 ชั่วโมง   
กิจกรรมการเรียนการสอน 
  กิจกรรมก่อนเข้าชั้นเรียน 
     1.  กิจกรรมผู้สอน 
   1.1 แจ้งผู้เรียนให้ศึกษาเนื้อหาจากเอกสารประกอบการบรรยายใน Classroom โดย
แจ้งผ่าน Email และผ่านระบบ Line ก่อนเข้าชั้นเรียน  
         1.2 เตรียม/โปรแกรม Image composite editor เพ่ือใช้ในการฝึกปฏิบัติการต่อ
ภาพ โดย Upload ให้นักศึกษาดาวน์โหลดผ่าน http://www.geog.pn.psu.ac.th/CAIAerial/ 
HtmlBook/211Aerail_Index.html และAgisoft PhotoScan Professional Edition ดาวน์โหลด
ผ่าน https://www.agisoft.com/downloads/installer/ 
  2.  กิจกรรมผู้เรียน 
        2.1 ดาวโหลดโปรแกรม Image composite editor และAgisoft PhotoScan ลงใน
คอมพิวเตอร์ และศึกษาเอกสารและดูวิดิโอตามท่ีได้รับมอบหมาย 
        2.2  เตรียมข้อมูลภาพ UAV  จากที่ปฏิบัติการถ่ายภาพจริงในงานภาคสนาม 
 กิจกรรมในชั้นเรียน 
     1.  กิจกรรมผู้สอน 
          1.1 หลังจากที่ผู้สอนและผู้เรียน Login เข้าระบบ Google meeting กล่าวทักทาย
ผู้เรียน จากนั้นกล่าวเพ่ือถึงภาพรวมในรายละเอียดเนื้อหาในการเรียนรายวิชานี้   
         1.2 จุดประสงค์การเรียนรู้ให้ผู้เรียนทราบ และถามทบทวนถึงสาระการเรียนที่
มอบหมาย ได้แก่ การดาวน์โหลดและติดตั้งโปรแกรม ขนาดพ้ืนที่จัดเก็บข้อมูล เป็นต้น       
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  1.3 ผู้สอนสาธิตวิธีการติดตั้งและการใช้งานโปรแกรมพร้อมอธิบายหลักการ/
สาระสังเขปในขั้นตอนการประมวลผลต่างๆ อาทิ การน าเข้า การ Stitch การตัดขอบภาพ และการ
ส่งออกข้อมูลภาพ 
        1.4 ผู้สอนสรุปขั้นตอนการใช้โปรแกรมประมวลผลข้อมูลภาพและการน าไปใช้งานใน
การท าแผนที่ในโปรแกรมด้านสารสนเทศภูมิศาสตร์  
  1.5 ผู้สอนสาธิตวิธีการติดตั้งและการใช้งานโปรแกรม Agisoft PhotoScan พร้อม
อธิบายหลักการ/สาระสังเขปในขั้นตอนการประมวลผลต่างๆ อาทิ การน าเข้า การAlign  Build 
Dense cloud, Mesh, texture, DEM,  Orthophoto และการส่งออกข้อมูล 3D 
        1.6 ผู้สอนสรุปขั้นตอนการใช้โปรแกรมประมวลผลข้อมูลภาพและการน าไปใช้งานใน
การท าแผนที่ในโปรแกรมด้านสารสนเทศภูมิศาสตร์  
      2.  กิจกรรมผู้เรียน 
          2.1   ตอบค าถาม/ฝึกท าแบบฝึกหัดท้ายบท/ร่วมเสวนาในชั้นเรียน   
         2.2   ฝึกปฏิบัติการบินตามกิจกรรมต่าง ๆ และค านึงถึงข้อบังคับต่าง ๆ อย่าง
เคร่งครัด 
          2.3  เขียนสรุปเนื้อหาสาระส าคัญโดยสังเขปเพ่ือบอกเล่าประวัติ และประโยชน์   
 หลังชั้นเรียน 
       1.  ผู้เรียน    
            1.1  เขียนสรุปเนื้อหาสาระส าคัญในแบบฝึกหัดท้ายบท 
  1.2  ประมวลผลข้อมูลภาพ UAV และส่งงานตามเวลาที่ก าหนด 
            1.3  ทวบทวนเอกสารและเรียนรู้เพิ่มเติมจากแหล่งเรียนรู้/สื่อที่ก าหนดให้ 
       2.  ผู้สอน     
            2.1 ตรวจผลงานผู้เรียนและส่งกลับผลเมื่อพบข้อที่ต้องปรับปรุงแก้ไข/ถ้าสมบูรณ์แจ้ง
กลับค าชม 
           2.2  สรุปรายงานผลการด าเนินกิจกรรมใน มคอ.5 เพื่อการพัฒนาและน าไปปรับปรุง 
 
กิจกรรมโดยภาพรวม 
  1.  การบรรยายโดยผู้สอน 
  2.  การอภิปรายชักถามร่วมกันในชั้นเรียน 
  3.  การศึกษาค้นคว้าเพ่ิมเติมจากต าราและเอกสารที่เกี่ยวข้อง 
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ส่ือการสอน/แหล่งเรียนรู้ 
        ผู้ เ รี ย นส าม า รถ เ ข้ า ถึ ง แหล่ ง เ รี ย น รู้ / สื่ อ ก า ร สอน ในกา รศึ กษ าครั้ ง นี้ บ น  url ที่  
http://www.geog.pn.psu.ac.th/CAIAerial/Page1/pageUnit/unitpage/index.html 
ประกอบด้วยสาระต่าง ๆ ดังนี้  
 1) เอกสารประกอบการบรรยาย / ใบงาน 
 2)  เอกสารคู่มือการปฏิบัติงานการส ารวจด้วยอากาศยานไร้คนขับของหน่วยงานภาครัฐ 
เข้าถึงด้วย url ที่  http://www.geog.pn.psu.ac.th/CAIAerial/pageUnit/unitpage/Unit7.html 
 3)  VDO แนะน าฟังก์ชันการใช้งานผู้ผลิต/จ าหน่าย    และ VDO ประกอบการบรรยาย  อาทิ 

เรื่อง URL link 
Microsoft ICE Tutorial https://youtu.be/9T-cvha8l1A 
แนะน าโปรแกรม image composite editor https://youtu.be/jQp7u0n66vU 
360 Panorama with DJI Mavic and Spark https://youtu.be/s7eeccO_AtQ 
Microsoft ICE - Basic Usage Tutorial https://youtu.be/2PvVikv4d-Y 
Agisoft Photoscan Workflow Tutorial https://youtu.be/Uny9nTr22go 
การท าแผนที่ภาพถ่ายทางอากาศด้วยอากาศยานไร้
คนขับ (UAVs)  

https://youtu.be/Xc8iOq2OxGI 

 
 

แผนการประเมินผลการเรียนรู้ 
 1.  วิธีการประเมินผลการเรียนรู้ 
  1.1  สังเกตพฤติกรรมการเรียนของผู้เรียน 
  1.2  ประเมินจากการตอบค าถามและการอภิปรายค าถามหรือแบบทดสอบ 
  1.3  การท าแบบฝึกหัดท้ายบท/แบบทดสอบย่อยรายจุดประสงค์  
 2.  ผลการเรียนรู้ที่ต้องการประเมิน 
 2.1 ผู้เรียนสามารถบอกหลักการและปฏิบัติตามขั้นตอนการประมวลผลภาพ ด้วย
โปรแกรม Image composite editor และAgisoft PhotoScan ได้อย่างถูกต้อง 
 2.2 ผู้เรียนสามารถเลือกวิธีการบันทึกชนิดแฟ้มข้อมูลและส่งออกข้อมูลได้อย่างเหมาะสม 
 2.3 ผู้เรียนมีสมรรถนะในการปฏิบัติงานการประมวลผลข้อมูลภาพจาก UAV เพ่ือน าไป
สร้างแผนที่และแบบจ าลองพ้ืนผิว 3 มิติได้อย่างแม่นย าและเหมาะสม 
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เนื้อหาทีส่อน 
1. ความน า 
 เนื่องจากสาขาวิชายังไม่มีโปรแกรม Agisoft photoscan  แบบซอฟต์แวร์ลิขสิทธิ์ใช้งาน 
จึงใช้ซอฟต์แวร์รุ่นทดลองใช้งานแบบ 30 วัน สามารถดาวน์โหลดได้ที่  https://www.agisoft.com/ 
downloads/installer/  การจัดท าเอกสารการใช้งานจึงอ้างอิงกับคู่มือการใช้งานของบริษัท Agisoft 
LLC และหน่วยงานที่มีโปรแกรมที่ได้รับอนุญาตการใช้โดยตรง อาทิ สทอภ. ซึ่งได้จัดท าและเผยแพร่
บนเครือข่ายอินเทอร์เน็ต รวมทั้งศึกษาเพ่ิมเติมจากสื่อวิดีทัศน์ที่เผยแพร่บน Youtube และเพ่ือเป็น
แนวทางการศึกษาและเรียนรู้การใช้งานโปรแกรมซึ่งมีความสามารถในการประมวลผลภาพดิ่ง 
แบบจ าลองระดับความสูงเชิงเลข และแบบจ าลองอาคาร/สิ่งปลูกสร้าง และหน่วยงานภาครัฐและ
เอกชนมีใช้งานกันแพร่หลาย จึงเห็นว่าควรมีการแนะน า/เรียนรู้การใช้งานโปรแกรมนี้ เพ่ือเป็น
ประโยชน์แก่ผู้เรียนในการเข้าใจวิธีการประมวลผลภาพจากข้อมูลยูเอวีในงานโฟโตแกรมเมตตรีต่อไป  
     Agisoft photoscan  เป็นผลิตภัณฑ์ซอฟต์แวร์แบบสแตนด์อะโลนที่ด าเนินการประมวล 
ผลตามวิธีโฟโตแกรมเมตริกร่วมกับกับพอยต์คลาวด์โฟโตแกรม เพ่ือสร้างภาพดิจิทัลเป็นข้อมูลเชิง
พ้ืนที่ 3 มิต ิมีอัลกอริธึมการกรองที่จับคู่ภาพสเตอริโอที่มีความหนาแน่นเพ่ือสร้างรูปทรงเรขาคณิตที่มี
รายละเอียดพิเศษข้ึนใหม่ สามารถส่งออกไปใช้งานในโปรแกรมและแอปพลิเคชัน ได้หลากหลาย  
 
2. ฟังก์ชันการท างานของโปรแกรม 
 การท างานส่วนใหญ่มีฟังก์ชันการท างาน 8 ส่วน ได้แก่ การน าเข้าข้อมูลภาพ    การสร้าง 

 

จุดภาพแบบสเตอริโอแกรม การสร้าง
จุดภาพคลาวด์หรือพอยท์คลาวด์ การสร้าง
พ้ืนผิวโครงข่ายแบบ mesh  การสร้าง
พ้ืนผิวจ าลองเชิงเลข (DEM) การสร้างภาพ
ดิ่ ง  แ ล ะกา รส ร้ า ง เ นื้ อ ผิ ว แผ่ น ภ า พ 
(Texture) และการปรับซ้อนการเอียงของ
ภาพประมวลผล มีล าดับขั้นตอนต่าง ๆ 
ดังนี้ 
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 2.1 หน้าจอการท างานของโปรแกรม    
  แบ่งออกเป็นส่วน 3 ส่วน ได้แก่ ส่วนของเครื่องมือการท างาน ได้แก่ แถบเมนูและ
แถบเครื่องมือ ส่วนที่สองเป็นพ้ืนที่แสดงขั้นตอนการด าเนินงานประมวลผล (Workspace) และส่วนที่
สามเป็นส่วนการแสดงผลข้อมูลในขั้นตอนวิธีการต่าง ๆ    

 
   1 = แถบเมนู                                            2 = แถบเครื่องมือ/ไอคอมปุ่มเครื่องมือต่าง ๆ  
   3 = พ้ืนที่แสดงสถานะ/ขั้นตอนการประมวลผล    4 = พ้ืนที่แสดงผลข้อมูล/ผลการประมวลผล              
   5 = แถบแสดงพื้นที่การด าเนินงาน                   6 = แกนแสดงระบบพิกัดข้อมูล 

 
 2.2  การสร้างแฟ้มข้อมูลหลักส าหรับการท างาน   
  โดยการสร้าง Chunk เพ่ือน าเข้า/จัดเก็บข้อมูลภาพที่ใช้ประมวลผล  โดยสามารถ
น าเข้าแบบเรียงล าดับภาพหรือแบบสร้าง Folder  ซึ่งอาจสร้างได้หลาย Chunk  ถ้ามีพ้ืนที่ว่างส าหรับ 

 

จัดเก็บข้อมูลภาพมากพอ  เช่น ข้อมูลภาพ 
70-100 ภาพ ควรมี พ้ืนที่ ส าหรับการ  
ประมวลผล/จัดเก็บข้อมูลภาพ   อย่างน้อย  

 

3-4 GB เป็นต้น  หลังจากสร้าง Chunk แล้วจึงคลิกขวาที่ chunk เพ่ือน าเข้าข้อมูลภาพที่จะใช้
ประมวลผล  ข้อมูลที่ประมวลผลในวิธีการต่าง ๆ สามารถเลือกดูได้ใน Chunk 
 

 2.3  การจัดเรียงข้อมูลจุดภาพ (Align Photo)  
  หลังจากสราง chunk เรียบรอยแลว จะเป็นขั้นตอนการท างาน โดยเริ่มตามขั้นตอน
ในแถบเมนู  Workflow ซ่ึงจะเห็นขั้นตอนตางๆ เริ่มต้นเป็นฟังก์ชัน Align Photo จะมีตัวหนังสือสี
เป็นด า แต่ฟังก์ชันอ่ืน ๆ ยังแสดงแถบการท างานเป็นสีเทา หมายความวา ขั้นตอนการท างานตอง
ท าขั้นตอน Align Photo ใหเสร็จกอนถึงจะท าข้ันตอนถัดไปได 
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  คลิกที่ Align Photo แลว เลือกคาฟงกชันหรือความละเอียดตางๆ ที่ความตองการ
ประมวลผลข้อมูลภาพ โดยขั้นตอนนี้จะเปนขั้นตอนการน าภาพมาจัดเรียงแลวเลือกเอาจุดของภาพที่
เหมือนกันมาสรางแบบจ าลอง หรือการสร้างจุดภาพแบบพอยท์คลาวด์ (Point Cloud) คือ เป็นกลุ่ม
ของจุด ณ ต าแหน่งหนึ่ง ๆ ในรูปแบบสามมิติ ซึ่งจะเก็บค่าต าแหน่งของวัตถุในพิกัด X,Y,Z เพ่ือใช้ใน
การการสร้างแบบจ าลองสามมิต ิAccuracy แสดงถึงความถูกตองของงานมีใหเลือก 5 ระดับ 

 

    Highest จะมีความถูกตองของจุดขอมูลสูง
สุด ท าใหใชเวลาประมวลผลนานมาก 
    lowest จะมีความถูกตองต่ าสุด ใชเวลา 
นอยที่สุด  

 

 

 

Pair preselection มีใหเลือก 3 แบบ  
     Disabled  ค านวณแบบทั่วไปโดยรวม  
     Generic   ค านวณพ้ืนที่ทับซ อนกันของ
ภาพที่ความละเอียดต่ าที่สุดที่สามารถน าภาพมา
คัดเลือกจุดได โดยไมตองมีคาพิกัดของภาพ  
     Reference จะค านวณแบบมีค าอ างอิง
พ้ืนผิวสูงต่ า(ภาพมีค่าพิกัด x,y,z) วิธีนี้ช่วยให้
จัดเรียงภาพและค านวณไดเร็วขึ้น 

 

 

Key point limit   ให้ใช้เป็นค่าตั้งตน  40000  
    ถาไมสามารถเรียงภาพได้อาจเพิ่มตัวเลขให 
   มากขึ้น แตจะใชเวลาค านวณมากข้ึนตามไป  
Tie point limit เป็นค่าบงชี้วาถ้ามีจดุทีเ่หมือน 

กันในภาพ ให้เลือกจุดที่ซ้ ากันตามค่าระบุมาเรียบเรียงเปนโมเดล และ Adaptive camera model 

fitting เลือกคลิกถูกไว โปรแกรมสามารถปรับจ านวนมากนอยของจุดตามความเหมาะสม 

  ปัญหาที่อาจเกิดขึ้นได้  คือ มีข้อมูลภาพที่ไม่สามารถ Align photo หรือจัดเรียง
จุดภาพได้ไมครบทุกภาพ  ซึ่งอาจเนื่องมาจากหลายสาเหตุ ได้แก่ ความคมชุดของภาพ ความซ้อนทับ
ของภาพ หรือศักยภาพของคอมพิวเตอร์และการเลือกวิธีประมวลผล  ซึ่งผู้ใช้งานควรตรวจสอบโดย  
เข้าไปดูในส่วน chunk  ถ้าแล้วพบว่าภาพใดที่มีตัวอักษร NA ก ากับท้าย แสดงวาภาพนั้นไมสามารถ



-221- 
 

  

เอกสารค าสอนรายวิชา 426-211 ภาพถ่ายทางอากาศ             ผศ.วุฒิพงษ์  แสงมณ ี

 

ค านวณจุดภาพได้  อาจต้อง Align photo ใหม่ทั้งหมดทุกภาพอีกครั้ง   ซึ่งอาจลองท าท าไปเรื่อยๆ
จนกวาจะหายครบทุกภาพ แตถ้าท าแลวไมหายแสดงวาภาพนั้นไมสามารถค านวณได อาจพิจารณา  
ตัด/ลบทิ้ง ทั้งนี้ต้องดูว่าภาพนั้นมีความต้อง
เนื่องข้อมูลหรือซ้อนทับมากเพียงพอต่อการ
ประมวลผลหรือไม่   ถ้าทุกภาพสมบูรณ์ให้กด
ปุ่มบันทึกแฟ้มข้อมูลเพื่อด าเนินงานต่อไป  

 
 

 
 

  ตัวอย่างข้อมูลจุดภาพที่ได้จากการประมวลผลในขั้นตอน align photo 
 

 2.4 ความหนาแน่นของจุดภาพ (Dense Cloud) 
  คือ การน าภาพที่ได้จากการ align มาสร้างเป็นจุด Vertex Color ในแกนสามมิติ
เพ่ือให้ได้รูปทรงของวัตถุที่ต้องการสร้างเป็นแบบจ าลองสามมิต ิ  
  2.4.1 ขั้นตอนนี้สามารถตัดจุด Point Cloud ที่ไม่จ าเป็นออกได้  โดยใช้เครื่องมือ 
Edit Tool 

 
 
                              ห รื อ ใ ช้ ค า สั่ ง ผ่ า น เ ม นู  
Edit>Gradual selection  ซึ่งจะมีสมการที่ช่วยใน
การตัดข้อมูลจุดภาพที่น่าจะมีความคลาดเคลื่อน 
(Point error)  ได้แก่ 

 
   

Reprojection error : ค่าข้อผิดพลาดในการฉายภาพ คือ ระยะห่างระหว่างจุดบนภาพซึง่จดุ 
3D ที่สร้างขึ้นใหม่ได้ (ผลจากส่วนซ้อนทับ/ต าแหน่งกล้องถ่ายภาพ) 
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Reconstruction uncertainty :  ความไม่แน่นอนของการสร้างจุดภาพใหม่ จุดดังกล่าวอาจเบี่ยงเบน
ไปจากพื้นผิวของวัตถุอย่างเห็นได้ชัด ท าให้เกิดสัญญาณรบกวนใน
พอยท์คลาวด์ (การลบจุดดังกล่าวจะไม่ส่งผลต่อความถูกต้องของการเพิ่ม
ประสิทธิภาพ หรือเพื่อให้มองเห็นได้ชัดเจนยิ่งขึ้นของ point cloud) 

Image count : จุดที่สร้างทั้งหมดมองเห็นได้อย่างน้อยจากรูปถ่ายสองรูป การกรอง
จ านวนภาพท าให้สามารถลบจุดที่ไม่น่าเชื่อถือออกจากระบบคลาวด์
ได้  (อย่างไรก็ตามจุดที่มองเห็นได้เฉพาะในภาพถ่ายสองภาพมีแนวโน้มที่

จะมีความแม่นย าต่ า) 
Projection Accuracy :  ช่วยให้สามารถกรองจุดที่ฉายภาพความถูกต้องต่ าออกไป 

 
  2.4.2 หลังจากลบข้อมูลจุดภาพที่กระจายออกนอกพ้ืนที่/นอกกลุ่มวัตถุจนแน่ใจ
ว่ามีกลุ่มจุดภาพที่รวมกลุ่มแล้ว ไปที่เมนู Work Flow > Build Dense Cloud เพ่ือเพ่ิมจ านวนจุด 
tile point ใหมากขึ้นกอนที่จะไปสรางพ้ืนผิวในขั้นตอน Mesh  (ถ้าคิดวามีจ านวน tile point มาก
พอแลว สามารถขามไปท าข้ันตอน mesh ได)้  ขั้นตอนนี้มีวิธีการประมวลผลเลือกใช้ ได้แก่ 

 

Quality :  ระดับคุณภาพมี 5 แบบ  
     Ultra high :  มีความละเอียดของจุดขอมูลสูงสุด 
                      ใช้เวลประมวลผลนาน (หลายช่ัวโมง) 
        lowest  :  มีความละเอียดต่ าสุด ใชเวลานอยที่สุด 
                    ใช้เวลาประมวลผลไม่นาน (10-30นาที) 

 

    และการกรองแยกความผิดปกติของจุดภาพ (Depth filtering)  มี 4 วิธี  
Disabled : แบบท่ัวไปไมเจาะจง มีการสุม่เพิ่มจ านวนจุดเข้ามา 

Mild : เพิ่มรายละเอียดไมมากจนเกินไปเนนใหผิวเรียบสมูท 

Moderate : เพิ่มจ านวนจุดใหพอดีสม่ําเสมอท าใหขอมูลไมขรุขระ
จนเกินไป 

Aggressive : เพิ่มจุดใหเยอะๆ มีความละเอียดสงู แต่อาจเกิด error ถ้า
คอมพิวเตอร์คณุลักษณะต่ า/หน่วยความจ าไม่พอ 

  
    หลังจากนั้นกดปุ่ม OK รอใหค านวณเสร็จ ซึ่งอาจใช้เวลานานตามวิธีและ
การประมวลผล รวมทั้งคุณลักษณะของคอมพิวเตอร์ที่ใช้งาน 
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                               ตัวอย่างข้อมูลจุดภาพที่ได้จากการประมวลผลในขั้นตอน Build dense 
cloud 

 
 2.5  การสร้างโครงข่ายพื้นผิว (Build Mesh) 
  เป็นการน าข้อมูล Point Cloud ทั้งหมด มาสร้างพ้ืนผิวของวัตถุในภาพจากจุด 
Dense Cloud ที่ได้เป็นรูปทรงพ้ืนผิวของวัตถุสามมิติ ไปทีเ่มน ูWork Flow > Build Mesh 
  แบ่งประเภทพื้นผิว (Surface type) ออกเป็น 2 ประเภท  
   Arbitrary เหมาะส าหรับการสร้างพ้ืนผิววัตถุ ได้แก่ อาคารสิ่งปลูกสร้าง รูปปั้น 
ให้มีความเรียบ วิธีนี้ใช้เวลาประมวลผลนาน ต้องการ RAM ที่มีความจุมาก เพราะจะใชการค านวณ
พ้ืนผิวในทุกทิศทุกทางเพ่ือให้แบบจ าลองมีความราบเรียบ ใชเวลานานในการค านวณ 
   Height field เป็นการสร้างพ้ืนผิวของวัตถุที่มีจ าลองแบบแบนราบ ลักษณะ
มุมมองแบบมุมบน (Top view)  เหมาะต่อการจัดท าแผนที่ภาพถ่ายทางอากาศ เพราะค านวณภาพ
พ้ืนผิวแบบระนาบตั้งฉากภูมิประเทศ  
  แหล่งข้อมูล (Source data)   สามารถเลือกแหลงที่มาของขอมูลจากขั้นตอน 
   สร้างพ้ืนผิว Dense Cloud  จะน าขอมูลจากขั้นตอน Dense Cloud มาค านวณ 
   สรางพ้ืนผิว Sparse Cloud จะน าขอมูล tile point จากขั้นตอน align photo 
มาใช้ค านวณ 
  จ านวนจุดภาพพ้ืนผิว (Face count)    เลือกความละเอียดของพ้ืนผิวโดยจะบอก
จ านวนโดยประมาณของหนาโครงขายที่เชื่อมกัน ระหวางจุดแตละจุด  มี 4 แบบ 
   High       :  90,000   จุด 
                          Meduim :  30,000   จุด 
    Low       :  10,000   จุด 
   Custom  :   ผู้ใช้ก าหนดเอง 
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  การประมาณค่าในช่วงการปรับแก้พ้ืนผิว (Interpolation) เปนการปรับแกพ้ืนผิว 
ขอมูลโดยการประมาณคา  
   Disabled    เปนการเพ่ิมจุดเพ่ือใหพ้ืนผิวสอดคลองกับความเปนจริงตามพอยด์
คลาวด์ที่มีความหนาแน่นสูงเท่านั้น 
   Enabled (default)  ให้โปรแกรมปรับค่าพ้ืนผิวและแทรกใหเหมาะสม ถาพ้ืนที่
ตรงไหนมีจุดเพียงพอก็จะไมสรางเพ่ิม มีข้อดีที่อาจช่วยปิดพื้นที่รูโหว่บางช่วงในแบบจ าลอง 
   Extrapolated  เปนการขยายขนาดรัศมีของจุดแตละจุดใหครอบคลุมพ้ืนที่ เพ่ิม
จุดนอยมาก (เพ่ิมเทาที่จ าเปน) โปรแกรมจะสร้างแบบจ าลองที่มีพ้ืนที่รูปปิดทั้งหมด (สามารถน ามาลบ
ออกได้ภายหลัง) 
  หลังจากนั้นกดปุ่ม OK รอใหค านวณเสร็จ ซึ่งอาจใช้เวลานานตามวิธีและการ
ประมวลผล รวมทั้งคุณลักษณะของคอมพิวเตอร์ที่ใช้งาน (เร็วกว่าแบบ Dense cloud เล็กน้อย) 

 
 

                   ตัวอย่างข้อมูลจุดภาพที่ได้จากการประมวลผลในขั้นตอน Build Mesh 
 

 2.6 การสร้างลายเนื้อภาพ (Build Texture)  
   คือ กระบวนการค านวณสีของพ้ืนผิวจากข้อมูลภาพถ่ายเพ่ือใช้กับพ้ืนผิวแบบจ าลอง 
Mesh ตามมุมและต าแหน่งของรูปภาพที่ค านวณได้ ท าให้แบบจ าลองโมเดลมีสีสันสวยงาม มีความ
ละเอียดของจุดสีเพิ่มข้ึน  ไปทีเ่มน ูWork Flow > Build Texture  จากนั้นก าหนดคุณลักษณะดังนี้ 

 

แบบวิธีแผนที่ (Mapping) มี 6 แบบ 
  Generic ท าใหภาพมีสีทั่วไป  
  Orthophoto จะเนนทางภาพ top view อยางเดียว     
  Adaptive Orthophoto ก็จะเนนทางภาพใหตั้งฉาก  
       top view และดานขางเล็กนอยปรับใหพอดี  
  Spherical จะเนนท าใหภาพเปนทรงกลม  
  Single Camera จะเปนการน าสีของภาพๆเดียวมาใส 
       ในโมเดลสวนของภาพนั้นๆ 
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   การปรับผสมสี  (Blending mode)  
    Mosaic (default)   เปนค าเริ่มต น ใช้วิธีค่าเฉลี่ยถ่วงน้ าหนักในกลุ่ม
พารามิ เตอร์ของจุดภาพที่อยู่ ใกล้ เคียงกั นแบบองค์ประกอบความถี่ต่ า  (Low frequency 
component) 
     Average จะใชคาเฉลี่ยของจุดภาพของภาพ  
    Max intensity  เลือกค่าจากภาพที่มีความเขมสูงสุดของกลุ่มจุดภาพ  
    Min intensity   เลือกค่าจากภาพที่มีความเขมต่ าของกลุ่มจุดภาพ 
    Disabled ทั่วๆ ไป ใช้วิธีค่าเฉลี่ยถ่วงน้ าหนักแต่เลือกองค์ประกอบความถี่
สูง (high frequency component)   
   ขนาดลายเนื้อภาพ (Texture size/count) คาจุดภาพของแบบจ าลอง ยิ่งมาก
ยิ่งละเอียด แตปกติใชคาเริ่มตน 4096 อาจปรับขนาดเป็น 2n x 2n จุดภาพ เช่น 256x256, 512x512, 
1024x1024 พิกเซล เป็นต้น 
 

 2.7 การก าหนดจุดควบคุมภาพ (Ground Control Point : GCP) 
  ในกรณีที่ต้องการสร้างแบบจ าลองความสูงเชิงเลข (DEM) และภาพดิ่งที่มีความ
ถูกต้องเชิงต าแหน่งสูงมากขึ้น ขั้นตอนส าคัญคือการก าหนดจุดบังคับค่าพิกัดข้อมูลภาพ ซึ่งต้องท าใน
ขั้นตอนหลังจากการ align photo   (อย่างไรก็ตามข้อมูลภาพที่ได้จากยูเอวีจะมีค่าพิกัดของภาพถ่าย
แนบติดกับข้อมูลภาพด้วยเสมอ สามารถประมวลผลได้แต่ค่าพิกัดในต าแหน่งอาจมีความคลาดเคลื่อน
จากหมุดอ้างอิงตามแนบราบประมาณ  0.5 ถึง 1 ม. และในแนวดิ่ง  5 ถึง 10 ม.ตามคุณลักษณะ
ของยูเอวีในแต่ละรุ่นและแต่ละยี่ห้อ)  
   การปรับความถูกตองเชิงต าแหนงของแบบจ าลองใหมีความถูกตองมากขึ้นกวาเดิม 
เรียกว่าวิธีก าหนดจุดควบคุมภาคพ้ืนดิน (Ground Control Point : GCP )  โดยการเลือกแถบ 
Reference จากนั้นในส่วน Marker คลิกขวา เพ่ือสร้างจุดควบคุม (Create marker) 
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  การก าหนดค่าต าแหน่งอ้างอิงสามารถท าได้ 2 วิธี  
   1) ก าหนดค่าโดยพิมพ์/กรอกต าแหน่งในแถบ Marker คลิกเลือกภาพ (1) 
จากนั้นคลิกขวาสร้าง Marker ที่ภาพ (2)  ในส่วนแถบ Marker พิมพ์ค่าต าแหน่งพิกัดและระดับความ
สูง  (3)  

 
 
    2)  น าเข้าแบบแฟ้มข้อมูล  ท าได้โดยคลิกที่ปุ่ม import  จากนั้นเลือกต าแหน่ง  

 

 

แฟ้มข้อมูล คลิกปุ่ม import เพ่ือน าแฟ้มเข้ามา   
เสร็จแล้วคลิกเลือกภาพ และคลิกขวากหนด
ต าแหน่ง Marker ให้จุดภาพตรงกับต าแหน่งที่
ก าหนดควบคุม 

 
  หลังจากเม่ือใส marker ครบแลว (กดปุ่ม Save กอนเดี่ยวจะกลับมาแกไขไมไดถาไป
ขั้นตอนถัดไป)   

เสร็จแล้วใหกดปุ่ม update   ไอคอนรูปลูกศรสีฟา  
 

กดปุ่ม Optimize camera 
จะมีพารามิเตอรตางๆ ใหเลือก  

จากนั้นกดปุ่ม OK  

 
 
  เสร็จแล้วให้ประมวลผลตามขั้นตอนในข้อ 2.4 ถึง 2.6  
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 2.8  การสร้างแบบจ าลองความสูงเชิงเลข  
  หลังจากเสร็จสิ้นกระบวนการตามข้อ 2.7 แล้ว ไปที่เมนู Work Flow > Build DEM 
จากนั้นก าหนดคุณลักษณะดังนี้  
   Coordinate : WGS 84 (EPSG::4326) เพ่ือให้ส่งออกแล้วสามารถซ้อนทับกับแผนที่  
         google map ได ้อ้างอิงพิกัดระบบภูมิศาสตร์ อย่างไรก็ตามประเทศไทยม ี
    เขตกริดในระบบ UTM แบ่งเป็น 2 เขตกริดคือ เขตกริด 47 กับ 48 (Zone  
    47, Zone 48)  สามารถเข้าไปก าหนดคาพิกัด Projected Coordinate  
    systems > world geodetic system 1984 > WGS 84 /UTM Zone  
    47N เมื่อเลือกแลว กดปุ่ม OK 
   Source data : Dense cloud 
   จากนั้นคลิกปุ่ม OK 

  
 

                                                                            ผลลัพธ์แบบจ าลองความสูงเชิงเลข 
 

 2.9  การสร้างภาพดิ่ง (Orthophoto)    
  หลังจากประมวลผลตามขั้นตอนหลักเสร็จแล้ว สามารถสร้างภาพดิ่งได้  ไปที่เมนู 
Work Flow > Build Ortomosaic จากนั้นก าหนดคุณลักษณะดังนี้  

 

Coordinate :  ก าหนด WGS 84 (EPSG::4326)  
                   หรือWGS84/UTM Zone 47N 
                   ตามวัตถุประสงค ์
 
จากนั้นคลิกปุ่ม OK 
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การส่งออกข้อมูลภาพดิ่ง ไปที่ File > Export 
orthomosic > Export JPEG/…> export  
เลือกแฟ้มข้อมูลตามนามสกุลที่ตองการส่งออก 
อาทิ *.jpeg, *.tiff, *. Kmz และ *.png เป็นต้น   

 
 2.10  การสรางรายงานผล 
    หลังจากประมวลผลเสร็จในทุกขั้นตอนแล้ว ให้จัดท ารายงานสรุปขั้นตอนการ
ประมวลผล โดยไปท่ีเมน ู File > Generate Report…> ตั้งชื่อแฟ้มข้อมูล คลิกปุ่ม OK > Save 
    ในรายงานจะประกอบด้วย ข้อมูลจ านวนภาพที่ใช้ประมวลผลภาพ  พารามิเตอร์
ต่างๆ ของข้อมูลภาพ และแบบจ าลอง เวลาการประมวลผล ความสูงในการบิน ความแยกชัด พ้ืนที่ใน
การถ่าย จ านวนจุดโยงยึด เป็นต้น  
 

แถบเครื่องมือ 
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แหล่งเรียนรู้เพิ่มเติม 
         1 .  ส าม า รถ เ ข้ า ถึ ง แหล่ ง เ รี ย น รู้ / สื่ อ ก า ร สอน ใน กา รศึ กษ า ครั้ ง นี้ บ น  url ที่  
http://www.geog.pn.psu.ac.th/CAIAerial/Page1/pageUnit/unitpage/index.html  
 2.  VDO แนะน าฟังก์ชันการใช้งานผู้ผลิต/จ าหน่าย    และ VDO ประกอบการบรรยาย  
อาท ิ

เรื่อง URL link 
Microsoft ICE Tutorial https://youtu.be/9T-cvha8l1A 
แนะน าโปรแกรม image composite editor https://youtu.be/jQp7u0n66vU 
360 Panorama with DJI Mavic and Spark https://youtu.be/s7eeccO_AtQ 
Microsoft ICE - Basic Usage Tutorial https://youtu.be/2PvVikv4d-Y 
Agisoft Photoscan Workflow Tutorial https://youtu.be/Uny9nTr22go 
การท าแผนที่ภาพถ่ายทางอากาศด้วยอากาศยานไร้
คนขับ (UAVs)  

https://youtu.be/Xc8iOq2OxGI 

 

 
ค าถามท้ายบท 
 1. จงบอกขั้นตอนการประมวลผลข้อมูลภาพจาก UAV เพ่ือน ามาสร้างแบบจ าลองพ้ืนผิว 
3มิติ (DEM) และภาพดิ่ง (Ortho photo) 
 2. จงอธิบายสาระสังเขปเกี่ยวกับหลักการประมวลผลข้อมูลภาพจาก UAV ที่น ามาสร้าง
แบบจ าลองพ้ืนผิว 3มิติ (DEM) และภาพดิ่ง (Ortho photo) 
 3. จงให้ข้อคิดเห็น/วิพากษ์ต่อขั้นตอนการแก้ไขปรับลบจ านวนจุดและพ้ืนที่การ
ประมวลผลในขั้นตอนการ Align photo และ Densed cloud ส่งผลอย่างไรต่อผลผลัพธ์ของ
แบบจ าลองพ้ืนผิว 3มิติ (DEM) และภาพดิ่ง (Ortho photo)  
 4. จงบอกปัญหาผลลัพธ์ที่ได้จากการประมวลผลข้อมูลภาพบิดเบี้ยวหรือขาดหลายหรือไม่
สมบูรณ์ตามที่วัตถุประสงค์ท่ีก าหนดไว้ว่ามีสาเหตุมาจากปัจจัยใดบ้าง พร้อมเสนอแนะแนวทางแก้ไข 
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